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t | Document Database Tools Window Help
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Subscription Folders

The Subscription service lets you “rent” by the month one or more folders on our server. You keep your
active projects in those folders, and otherwise have the full capability of SurveyPro available while the
folder is active. Note, you cannot save a SurveyPro file locally unless you own a full license of SurveyPro

— otherwise, you must maintain an active subscription to retain access to your survey, data, and reports.
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The SurveyPro subscription service is intended for people who have an occasional short survey project or
as a way of sharing a SurveyPro file without requiring everyone to own a full software license for one
project. There are two restrictions on projects kept in Subscription folders: (1) only one questionnaire
document is supported in a folder, and (2) NetCollect web surveys can only be published to our

QuestionWeb server.

If you have a Full License AND are using the subscription service, this enables the full software capability
including the choice of saving project files on your local disk or in Subscription folders and/or publishing
NetCollect to your own web server -- in other words the traditional software license with a special file

sharing option.

The option of purchasing a software license or an additional subscription folder is always available.
Contact Apian Sales at sales@apian.com or 800-237-4565.

File Menu

Chapter Contents

File, Save

File, Save As

File, Open

Subscription Folders

Subscription Folders, Login

Subscription Folders, Save As

Subscription Folders, Open

Subscription Folders, Delete

Subscription Session Already Open
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File, Save

The Save button allows you to save the current work to whatever file it was opened from, whether that

was a local disk folder or a Subscription folder.

[ See Also ]

Subscription Folders, Save As

File, Save As

If your SurveyPro is licensed under a Subscription folder then this saves to subscription folders, otherwise

the main File, Save As menu always writes to a local disk file.

[ See Also ]

Subscription Folders, Save As

File, Open

If your SurveyPro is licensed under a Subscription folder then this opens from subscription folders,
otherwise the main File, Open always reads from a local disk file.

[ See Also ]

Subscription Folders, Open

Subscription Folders

The Subscription service is a way to rent a folder by the month on the Apian server where a project file
can be saved. You have access to almost all features of SurveyPro during the time the folder is active,

but can only save the file there rather than on your local disk. It is intended as a trial use of the software

www.Apian.com
(206) 547-8392

Support@apian.com




éSuweyf. 0

for production, for people who only have an occasional short survey project, or as a way of sharing a

SurveyPro file without requiring everyone to own a full software license for one project.

The Subscription Folders menu item will appear in a full software licensed installation so you can open or
save to subscription folders when desired. A Subscription licensed installation uses the Subscription

Folders, Save As and Subscription Folders, Open directly since the local hard disk storage is not

available.

Each Subscription folder can hold one active SurveyPro project file at a time. You can change to a
different active project by saving into that folder with a new name which will cause the previous file to
become inactive. After that it is accessible as a read-only file, but cannot be edited or data added. If you
find yourself doing much of this you may find that a full software license, which can save both to your
local disk and Subscription folders, will be more convenient and a better value.

Files are sent in an encoded format over an https SSL encrypted secure link to the server, and every
transaction message between your SurveyPro and the server is authenticated by the folder name-

password combination you provide. The server itself has a high level of security.

To use the subscription service, please begin by placing your order for a folder at www.apian.com. Once

your order is processed, you will receive an email with your folder name and temporary password.

Subscription Folders, Login

File > Subscription Folder > Login allows you to enter the folder ID and password for one subscription

folder:
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SurveyPro Subscription Service Login @

Folder
B123456

Paszsword

""""" | [] Remember password
Change Password

Any valid folder will do for login since this just enables access to the services. You can open or save to
any folder for which you have the correct password.

If you ask the system to remember your password it will be kept in your computer’'s Windows registry --
more convenient but possibly less secure.

If a new folder has its temporary password then you supply the temporary here and click Login which will

ask you for a password of your own to complete the login (see Change Password).

Change Password button is available to edit your password.

Change Password

A temporary password is assigned when a folder is first rented, but the first time you log in you will be

asked to change it to a password of your own:
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Change Subscription Password E]

You have asked to change the folder’s password.
Please provide your new password for folder [A001462]
Type new password:
Type again to confim:
Remember password

Passwords are 8to 16 characters long, case-sensitive
Ise a mix of letters, numbers and/or punctuation

Ise the basic character set up through y (except < = arl)

Set MNew ] [ Cancel ]

The password is yours, please be sure to write it down. Apian staff cannot retrieve it for you although the
registered account owner can request that we reset it if lost.

The password you set can be changed later using a button in the login dialog.

The rules for the password require something non-trivial and hopefully non-obvious. It can use the ANSI
character set which includes most European accented characters. It cannot have the full Unicode set
such as oriental or other extended alphabets, nor can it have the < > | characters. Blanks are allowed. It

iSs case-sensitive.

Examples:
Sunshine148 Yes, mixed letters and numbers
1-;-4-8- Yes, eight mixed numbers and punctuation
Sun :) shine Yes, twelve mixed letters and punctuation
Sun®©shine No, uses an extended Unicode character
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Password No, all letters and obvious

>MyCat No, too short and uses >

If you ask the system to remember your password it will be kept in your computer’'s Windows registry,
more convenient but possibly less secure.

Subscription Folders, Save As

Save As saves a file to a subscription folder to a project file name you specify

\SIUWGYPW Subscription File Save

Previolsh: Uised Folders

|{B337633] Cliert Survey AF28 10514 PM.
[B957251] MyTest 441/200917:59:34 AM
[B992017] <folder expired>
<add folder:

Folder Propesties

FCI|dE.'|'Z_.':": - Pasaword: (sssssass

Remember passwird

Mame: | Cliert Survey [

Any folders you have used before are listed here along with the project name currently active in that
folder and the last time it was saved. This is not a list of all the folders on the server that you might have
permission to access, just the ones you have accessed before from this computer.

You may see folders with <folder expired> or other notation letting you know it is not currently active.
Contact Apian Sales at sales@apian.com or 800-237-4565 to re-activate.
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The last entry is <add folder> which tells the system you want to access a new folder, adding it to your
list. If you are accessing an existing folder just enter its name and password. Otherwise please order the
new folder from Apian Sales at sales@apian.com or 800-237-4565, and once you receive login

information you can add the new folder here.

Attempting to save to a project name which conflicts with something already in the folder asks for

confirmation:

Confirm Replace Active File

Save As
You have asked to save in the folder [AD00763] using the
new project file name "Subscription SwrTest”
The folder already has the project file "a new proj”

Saving to the new name will make it the new active file, and
cause the exdsiting file to be permanently locked into a read-only mode

Replace Active

Other Options

* Save to a different folder.
* Perhaps you have outgrown the intent of the subscription program

if you need a new folder or want to upgrade to a fully licensed DecisionPad
please contact Apian Sales at 800.237 4565 or sales@apian .com
or use the Help menu's DecisionPad web site link

Cancel Save

It reminds you the previous project will become inactive --read-only -- which you confirm by clicking the
Replace button. This is similar to the file overwrite warning in a disk file system. There are a couple other

notices formatted a little differently depending on the details of the conflict.

Subscription Folders, Open

File > Subscription Folder > Open allows you to read a file previously saved to a Subscription folder:

www.Apian.com
(206) 547-8392

Support@apian.com




\ﬁSurvevwm >

\SIUWEfpm Subscription File Open

Previoushy Used Folders

|[B997633] Cliert Survey AF2A08 10514 PM.
[BS57E51] MyTest 441720059 11:55:34 AM
[B592017] <folder expired>
<add folder:
Folder Properties

Remember password Cancel

Folder- /E353755 | Fasswurd:.-------- .

The active projects are shown with their last write times. This is not a list of all the folders on the server

that you might have permission to access, just the ones you have accessed before.

You will see a <bak> for a backup of the project file capturing the status from before the last save. If you
want to undo the changes you've made since you last saved the file, you can open the <bak> version and
re-save to the main name to step backwards.

You may also see <bak> for previously completed projects which can be opened for read-only access.
You can print its worksheet or reports or export data but you cannot edit it until saved as an active
subscription project or to a local disk (full Software licenses only).

You may see folders with <folder expired> or other notation letting you know it is not currently active.
Contact Apian Sales at sales@apian.com or 800-237-4565 to re-activate.

{Sample] is a folder everyone can access with the SurveyPro sample files used in the Tutorial Guide. It
does not have a password of its own.
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The last entry is <add folder> which lets you tell the system you want to access a new folder, adding it to

your list.

If you are opening a file from the Most Recently Used file list or from the startup dialog’s Last File entry,
and its folder is different than the login folder, you will be asked for its password:

To access the folder [AD01100] please
enterits Password: | i

[ ] Remember Password

ok || cancal |

Subscription Folders, Delete

File > Subscription Folder > Delete allows you to remove a file from your subscription folder using this

dialog:

[

urveyrro subscription >ervice Uelete File

2JE3

Previoushy Used Folders

B9576593] «folder expired:

[B558017] <folder expired:>
<add folder:

Folder Properties

Folder: Password:

Remember password

Cancel

CAUTION: This is a permanent delete with no ‘undo’ option. The file is removed from the server's file
storage; so be sure you are really done with the file before clicking delete and OK.
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You cannot delete a file which is currently open in SurveyPro. Use File->New or open another file to
close this one, then return here to delete it.

Subscription Session Already Open

p
Server Session

The server has a session underway for this folder that started Apr 23, 09 at 12:02 pm,
! either for another user currently sharing this folder or a previous session that was not dosed properly

Do you want to stop this other session to open yours now?

Yes ] : No { [ Help

Only one SurveyPro user at a time can be working with a project in a Subscription Folder. If one person
is using the file and someone else tries to access it the message above appears to ask what to do. If the
session is pretty current and you know there is someone else likely to be sharing it then say No so you do

not disconnect them.

This warning can also appear when a previous session did not get closed out properly, most often
because SurveyPro was not closed before turning off the computer or because the internet connect was

lost during a session. Then you waould answer Yes here to let it know it is safe to start a new session.

Publish Questionnaire as XML

XML publish offers you a way to communicate the content of a questionnaire in a structured fashion. Itis
not the full layout, thus not the equivalent of an .sp5 file, rather it is aimed at several communication
purposes. You can export the content, people can make changes of various kinds, and in some
scenarios it can be imported back into SurveyPro without copy/paste of each item. This XML process can
be used to:
www.Apian.com
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e Make editorial inputs on a draft survey

o Make a template for people to provide draft input including typical scales

e Maintain a library of questions and scales using XML editors

e Provide a structured English survey for translators, allowing a direct import of the translations into

SurveyPro (standard Windows character sets).

When you select the Document, Publish Questionnaire, XML File it brings up this dialog box:

-

Publish Questionnaire as XML

-,

#ML File Contents

" Fully detailed szale definitions

(" Language translation format

Tiles ta Expart
O |
" Selected

(" Scale descrptions and samples list

[v By Pages

Cancel

These choices reflect the various objectives above.

XML File Contents

Scale Descriptions

Scale Descriptions and Samples List

Fully detailed scale definitions

Language translation format

[ See Also ]

Suitable Editors
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Scale Descriptions

Scale Descriptions are intended to collect editorial feedback from people who will use an XML editor like
MS Word which has the ability to track changes and comments. These are not intended to be imported
into SurveyPro directly, but as input to the survey designer for their editing of SurveyPro. InWord the
XML would look like this:

9] A2N_StaticPin.xml - Microsoft Word

£ Fnal Showing Markup = Show~ | @2 - i3 -] - [B] @

P fle Edit Mew Insert Fomat Tools Table Window Help

PR LR S A B9 o8 7 |\‘1jq[1nn% v@,|41gead._’§:£nlnrma\+uft:v'nmesNewF

g R T R T S BT AR ERER IR SRR AR IR SRR

(4 SurveyProQuestionnaire_1

1

[ TnlineText[ Welcome to the xvz survey. You should have a personal ID code which was assigned to enter this su.rvey.
[Short Countable Written -- Single answer] = text answers Ansviers )

2

4 Question

Something to enter
{{Answers ([Non-repeating or Long Memo Written Answers] = text answers Ansviers )

Multi answer with other and explicit n/a
{# Answers {[Miulti answer with other and explicit n/a] = Multi-answer checkboxes: Alpha: Beta: Gamma Answers®)

The XML ‘tags’ indicate the survey question-answer structure. The <Answers> show the scale name
used in SurveyPro and a brief description of its definitions such as the checkbox labels or number
formats. The people providing feedback should also have a copy of the draft survey (printed or web
pages) for the layout and context.

When you get the edited XML back, open all the files in a browser, open the project in SurveyPro and
incorporate the suggestions using the normal SurveyPro editing tools. Generally speaking we would not
expect to import these informally edited files.
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Scale Descriptions and Samples List

Scale Descriptions and Samples List are intended as a way for you to provide a template that someone
else can use to draft the survey within a structure that can be imported with less work than a pure text
document. Typically you would build a template survey with a few sample tiles and/or some boilerplate
content, plus any scales you would typically use beyond the built-ins. The scales available appear at the
end like this:

<SampleAnswersz
zAnswers>[Short Countable Written -- Single answer] = text answers</Answers>
<Answers=[Short Countable Written -- Multiple answer] = text answers</Answers:>
<Answers:=[Non-repeating or Long Memo Written Answers] = text answers</Answers:>
<Answers=[Date like Apr 30, 2002] = Dates like Apr 30, 2007 </Answers>
<Answers:=[Yes/No (Yes best)] = Checkboxes, first box is best: Yes; No</Answers:>
<Answers=[Yes/No (No best)] = Checkboxes, last box is best: Yes; No</Answers:>
<Answers=[Yes/No (Unordered)] = Checkboxes: Yes; No</Answers>
<Answers=[Yes/Uncertain/No (Yes best)] = Checkboxes, first box is best: Yes; Uncertain; No</Answers:
<Answers=[Excellence -- 4 levels] = Checkboxes, first box is best: Excellent; Good; Fair; Poor</Answers:>
<Answers>[Excellence -- 6 levels] = Checkboxes, first box is best: Excellent; Very Good; Good; Fair; Poor; Unacceptable</Answers>
<Answers>=[1 High to 5 Low Rating] = Numeric ratings from 1 to 5, lowest best</Answers:>

Using an XML editor (see Suitable Editors suggestions) the person drafting the survey can pick up a
useful looking scale from the list. These will automatically match up on import. Or they can create an
<Answers> tag of their own with a description of what they want, like a list of checkbox labels, which you

can turn into a proper SurveyPro scale on import.

There are four kinds of tiles that can be imported:

=Question=

Skip next page?

zAnswers=[Yes/No (Unordered)] = Checkboxes: Yes; No</Answers:
</Question=
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<Grid=
values
<Row =Price</Row >
<Row =Quality </Row =
<Row =Appearance</Row >
- <Columnz
Importance
zAnswers=[1 High to 5 Low Rating] = Numeric ratings from 1 to 5, lowest best</Answers:>
</Columnz
- <Column:
Performance
<Answers=[1 Low to 5 High Rating] = Numeric ratings from 1 to 5, highest best</Answers>
=/Columnz=
=/Grid=

<InlineText=This is an explantion of the questions which follow: </InlineText>

=FixedText>=This is a label placed on the page rather then inline. </FixedText:=

Fully detailed scale definitions

Fully detailed scale definitions: Intended for building libraries because the scale descriptions are
complete and precise. You would export fragments of XML to contribute to the library being built in a
good XML editor (see suggestions below). Then to construct a new survey you would pull the questions,
grids and text tiles you want into a temporary XML file that can be imported. See Import XML

Questionnaires. A typical scale in this format is:

<Checkboxes=
=MName:=Agree/Disagree -- 4 levels</Name:>
<L =Strongly Agree</L>
<L =Agree</L>
<L=Disagree=</L>
<L =Strongly Disagree</L>
<FirstBest /=
<Legends=nal|ot|SA|A|D|SD</Legends>
<{Checkboxes=

Or for number scale with formatting template:
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<Mumbers =
(1,234.00)1
<Name =custom currency</MName:>
<Max=0.00</Max

</Numbersz

Language translation format
Language translation format: Tightly structured for unambiguous translation and automatic import into an
exact copy of the survey it was published from. The steps are to:
e Publish the completed survey in the base language, such as English, to XML for each translation
language
e Provide the translator with a clean layout copy of the survey for reference - print a paper copy or
publish to a web server.
e Save copies of the project .sp5 exactly as XML published for import later.

Translators do the translations where indicated in their XML file using a good editor (see below for
recommendations). They must not add, move or delete any of the XML elements, only change the

wording where indicated.

Import the file following the instructions detailed Import XML Questionnaires.

If the process was followed properly the import will replace all the labels automatically.

What the translator sees are all the words in the survey. For scales, they only have to translate each one

the first time it is used. For example:

<Question @="14|11]|4c22-v4cl-653|7">
Translate question here
<Was>Skip next page?</Was>
- «Checkboxes S="7]|2">
<L =Translate label 1 here</L>
<L >Translate label 2 here</L>
=Was=Yes; No</Was=>
</Checkboxes=
</Queastionz
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Whether the Q= and S= codes within the <Question> element show up depends on the XML editor the
translator uses. Either way they must not change them since these are how SurveyPro import matches

things up automatically.

The English labels appear within the <Was> tags. Leave those alone and supply the translations
immediately above where it says “Translate question here” or “Translate label 2 here”. Keep the

translation entirely within the bracketing element.

After publishing you will get this reminder to save the .sp5 for import:

-,

Publish XML

Reminder: translation import will require an exact match.
Before making any changes please save a copy of this project
for each language translation to be imported.

Any discrepancies will cause the automatic import to stop and require that you copy-paste all the

translations one tile or label at a time.

ByPages: Publishes the XML with page breaks and <FixedText> tiles. Typically not used with templates.

Tiles to Export: Controls which inline tiles to export, generally used when building up a library.

Suitable Editors

At this writing here are some handy XML editors:

MS Word — most useful for its change and comment tracking capability. Not as easy to use for XML
editing as some of the others.
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XML Editors —these are evolving all the time; you can check for the latest by doing a web search for

“Freeware XML editor”. For example:

ConTEXT or NotePad++ -- Tabbed editing and color-coding to differentiate between tags and

data
Microsoft XML Notepad or XML Marker — Tree view of the tag organization

Browsers — a great way to look at files people send to you when you do not need to edit them. Browsers

also do structure testing for legal XML, handy before attempting import.

Import XML Questionnaires

These instructions are for All Files except Translation files. For information on how to import XML

translation files go here: Translations Files

Select the menu item Document, Import Questionnaire, XML File. You will be asked for the file name. If
the questionnaire already has some tiles and you have selected one, you will be asked where to insert

the import:

g |

Import XML

P Imported questions will be added before the selected tile,

Yes to do so, Mo to insert at end or Cancel to stop import

Mo Cancel

Then the file is read and tiles are inserted for the <Question>, <Grid>, <InlineText> and <FixedText>
elements of the XML file. Assuming the XML structures are OK and this was not a translations file, the

scale information in the XML will be collected and presented in this scale matchup wizard:
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XML Questionnaire Import Scale Matchup
Imparted File Scale Selection
For Qusstion: Agsign Scale: |-(§| |
Ancther Short Countable ‘Written - Single answer s

Short Countable Wiitken - Multiple answer
Mor-repeating or Lotg Mema Written Answers
Date like Apr 30, 2007

YesiMo [Yes best)

ez/Mo [Mo best)

Yes/Mo [Unordered)

ez dncertain/Mo [Yes best)

Scale Information Provided: Ercelence - 4 levels
Excell - B level
Checkbow scale, with explicit MA, other blank, allow multiple 1 ﬁizhepgcg LDWBFT:[;Q
ANFWErS: 1 Low ta 5 High Rating
Alpha -3 to 3 Rating (3 best) v
Beta : - B '
Gamma

Selection's Definition:

¥ Skip steps where the scale was matched unambiguousiy

Help Cancel ¢ Last Mest >

It is a Wizard which steps through the questions and the grid columns. It starts by showing only the
cases where the scales did not get matched automatically, or where there is more than one possible
match. The question and scale information imported is on the left, and the scale you assign is on the

right.

In the example above, to assign a scale you could select an existing scale that works, copy an existing
scale and modify it, or insert a new scale. Files published with the scale names or drafted using the
<Answers> list options will match on the names, or show whatever the XML shows as hints for the scale.
Files published with the full scale details, usually used for libraries, will match to the built-in scales on any
you added. When the details are in the XML as above, when you add a scale it will preload the new scale

with the XML details like the labels and other blank.

If you turn off the Skip steps where the scale was matched unambiguously checkbox you can step

through all the steps and the matches that were found to verify them.
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XML Questionnaire Import Scale Matchup
Imparted File Scale Selection
For Questior: Aasign Scale [* are best matches): |-(§| |
Rank best 3 *Flank Best 3 K

Short Countable Writken - Single answer
Short Cauntable 'writter - Multiple atewer
More-repeating or Long Memo Written Answers
Diate like Apr 30, 2007

Yez/Mo [Tes best)

Yes/Mo [Mo best)

ez/Mo [Unordered)

Scale Information Provided: Yes/Uncertain/MNo [Yes best]
- - - Excelence - 4 levels
Hanklng scale, allow skips, allow ties: Excellence - F levels
Firat 1 High ta 5 Low Rating
?ﬁ_cdond 1 Low to B High Rating v
it Tt '

Selection's Definition:

Forced rank 3 best:
First
Second
Third

™ Skip steps where the scale was matched unambiguousiy

Help Cancel ¢ Last Finish

When the Wizard has found possible matches they are listed first and marked with an asterisk.

Click the Finish button to apply the assigned scales at any time to the imported tiles. If not all the tiles
have been assigned there will be a warning dialog to let you either go back to assign the rest or to accept

what you have leaving the rest to be assigned later.

Translations Files

Files sent out for Translation (the fourth option in the XML publish: Language translation format) are much

simpler. You first open the copy of the project .sp5 file you saved after the publish, then start the import.
Assuming the alignment has been preserved it will replace all of the labels with the translated ones in a
few seconds. Misalignments will stop the process and require that you either clean up the XML file or use

copy-paste.

Import checks the project to be sure that the number of questions, grids and scales do not exceed the
specified limits. Demo users note that these limits are fairly small so your import experiments will need to

be simple ones, just enough to see the concept.
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[ See Also ]

Language translation format

Import Text Questionnaires

SurveyPro5 adds a new way to import questionnaire text from plain text files. It goes beyond the previous
method available in SurveyPro4, having been enhanced with the scale setting dialog from the XML
Import. Itis a more limited import method than XML. Text import does not permit distinguishing tile types;
they all come in as questions, one per text paragraph, and there is no scale information. However some
users may prefer the more familiar text editors, or may already have Word questionnaires they wish to

import. The scale matchup wizard looks like:

Text Questionnaire Import Scale Setting
Imparted File Scale Selection
For Qusstion: Agsign Scale: |-(§| |
Une question Short Countable ‘Written -- Single answer s

Short Countable Wiitken - Multiple answer
Mor-repeating or Lotg Mema wiritten Answers
Date like Apr 30, 2007

YesfMo [Yes best)

Yez/Mo [Mo best)

Yes/Mo [Unordered)

Yezdncertain/Mo [Yes best)

Ercellence - 4 levels

Excellence - B levels

1 High to 5 Low Rating

1 Low ta 5 High R ating

-3 to 3 Rating [3 best) w

Selection's Definition:

Help Cancel ¢ Last Mest >

Pick the appropriate scale from the list on the right and click Next, continue until you have assigned all

you want.

www.Apian.com
(206) 547-8392

Support@apian.com




ﬁfSun\'eyf. 0

At the end of the list there is an option to convert the “question” to a graphic plain inline text tile, such as a

subhead or explanation that does not have a scale:

Scale Selection

Azzign Scale: JEJ

Murmber, nao fraction ”~
Percent, na fraction

Diallars, no fraction

E-mail Addreszes

LS ZIP or Canada postal codes

Social Secunty Humbers

Phaone number with area code

States

Countries

Apian 4-alphanumeric user |D

Apian B-alphanurmernc uger 1D

All-digits uger D for scanning

Test tle - no zcale w

Import checks the project to be sure that the number of questions does not exceed the specified limits.
Demo users note that these limits are fairly small so your import experiments will need to be simple ones,

just enough to see the concept

Printable Answer Summary

This new feature allows your respondent to have a page at the end of the survey that shows all of the
respondent’s answers. This enables them to review it conveniently and perhaps print a copy for their
files. The survey pages are displayed in the format the respondent saw earlier, including any
randomizations. No extra design work is required because all of your layouts and instructions are

preserved.
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Skip next page? ves v'No

This is page 3, skippable --
Strongly Agree JAgree Disagree  Strongly Disagree  N/A

Randomized grid rows:

Importance Performance
High Low Low High
1 2 3 4 5 N/A 1 2 3 4 5 N/A
Appearance v v
Price v v
Quality v

When your survey has skips, only the questions a given respondent saw on pages before the answer
summary page will be shown. An embedded launch which skips over page one will exclude page 1 as

will the explicit page exclusion setting below.

The summary itself is actually a special graphic tile that can be placed on any page after all the questions

you want summarized have been asked.

You can place it on the Finish page or create a new page of its own just before the Finish page. The
Summary tile cannot be on a pure “thanks” page — one after the respondent has clicked the Finished
button -- because Finish sends the respondent’s data to the .sdh answer file. At that point the answers
are no longer available to the survey handler; an answer summary after finish would display questions but

no answers.

Generally you should put a text tile or two of explanation before or after the answer summary tile so it is
clear to the respondent that this page is for review only and the answers cannot be changed here.
Remind them to use the survey back button (not browser back) to make changes.

To add the answers, first decide which page will show the answer summary. Use Documents, Page List

to create a new page if needed or scroll the correct page into the editing view.

www.Apian.com
(206) 547-8392

Support@apian.com




dsurvavFrn 5
1

The insert a new Inline Text/Graphic tile and select Web Answers:

nline rapl

Web Answer Summary |

Content Type
’7(‘ Text ( Picture  Line ‘

MNOTE: This is for NetCollect surveys onfy

ok | Cancel Help

When you click OK it will display a placeholder tile in the design screens:

Web Page 5:

Printable Answer Summary
for NetCollect surveys

When you print a preview to your local browser a placeholder will appear again:

‘ Printable Answer Summary Tile

Once the survey is on the server the full answer set will appear.
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Add Inline Text tiles as needed to explain to the respondent what the page is about and publish normally.

Excluding Pages from the Answer Summary

Go to Document, Edit Page List, select each page you want to exclude and press the Edit button to get:

Properties of Page 1 of 4 <]

— Description
ILDgin Page]

— Header

Footer
¥ Use onpage [T Enable progress bar ¥ Use on page

Fercent completed: |auta

— Mavigation

[~ Enable advanced exit page settings

I¥ Exclude page from Printable Summary

0K I Cancel Help

Set the Exclude Page from Printable Summary checkbox and click OK. Exclusion would be appropriate
when a page is purely explanations, instructions or the login which are not useful for the summary.
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Respondent Survey Completion Time

O Q31 [auto]: NetCollect Pages
O Q32 [auto]: MetCollect Respondent Elapsed Time

A new automatic data field has been added to record the time in seconds it takes each respondent to
complete the survey. It gives the total time from first access of the login page to when they click Finish.
Pausing the survey does not stop the clock — only the final submission.

The data is collected in the automatic question (Q32 in the example above) and can be reported like any
other question with a number scale. SurveyPro will assign this question the built-in number scale with

zero fractional digits, or if this is no longer available it will be recreated.

SurveyPro License Agreement

APIAN SOFTWARE LICENSE AGREEMENT for
SurveyPro SUBSCRIPTION or SINGLE-USER or WORKGROUP

YOUR AGREEMENT TO LEGAL CONTRACT:

CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THE SOFTWARE.
YOUR USE OF THE SOFTWARE INDICATES YOUR ACKNOWLEDGEMENT THAT YOU HAVE READ
THIS LICENSE, YOU UNDERSTAND IT, AND YOU AGREE TO BE BOUND BY ITS TERMS AND
CONDITIONS. IF YOU DO NOT AGREE TO THESE TERMS AND CONDITIONS, RETURN THE
SOFTWARE AND USER MANUALS TO THE PLACE OF PURCHASE WITHIN 30 DAYS FROM THE
DATE OF PURCHASE AS EVIDENCED BY A COPY OF A VALID RECEIPT AND YOUR PURCHASE
PRICE WILL BE REFUNDED.
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APIAN SOFTWARE LICENSE AGREEMENT for SurveyPro

SINGLE USER, WORKGROUP, or SUBSCRIPTION LICENSE

This Apian Software License Agreement ("License Agreement”) is a legal agreement between you and
Apian Software, Inc. ("Apian”) for the use of Apian Software product programs and files identified above
("Software"). Software consists of the computer program, its accessory programs and included files, and
may include associated media, printed materials, any "on-line" or electronic documentation and also
includes any updates and supplements to the original Software provided to you by Apian. By installing,
downloading, accessing, copying, or in any way using the Software, you agree to be bound by the terms

of the License Agreement.

Ownership of Software, Copyright, Trademarks Retained

The Software is the property of Apian Software, Inc. The Software is protected by copyright laws and
international copyright treaties, as well as other intellectual property laws and treaties. The Software is

licensed, not sold. All rights not expressly granted are reserved by Apian.

Grant of License. Apian grants you the non-exclusive, non-sublicensable, limited license to use the
Software so long as you comply with all the terms of the License Agreement for the Software use you

have paid for.

SINGLE USER LICENSE:

You may install and use this Software under a Single License as either (1) a PERSONAL Configuration or
as (2) a SINGLE-USER SITE Configuration, but not both.

In a PERSONAL configuration you may install the Software wherever you are working, so long as it used
by one individual and no other. You may install the Software in machine-readable form on any

computer(s), including on a network server, solely for one person’s individual use, and so long as no
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other person can access the Software. You may NOT allow more than one individual to use the Software

at any time under this option.

OR

In a SINGLE-USER SITE configuration you may install the Software at a single Site. It may be used by
any person who normally works at this site, so long as the Software is used by no more than one person
at a time. You may install the Software in machine-readable form on one computer only (workstation or
LAN server). The Software may be accessed by a person who normally works at the site on the one
network server over a dial-up connection, Local Area Network, Virtual Private Network, or its equivalent

where the program is executed directly from the single copy on that server.

You may not combine elements of the PERSONAL and SINGLE-USER SITE Options.

If you need the right for more than one person to use the Software, please purchase a Workgroup

License.

WORKGROUP SITE LICENSE:

If you have purchased use of the Software under a Workgroup License, you may install the Software in
machine-readable form for use at a single site. A Workgroup License is limited to a specified number of
simultaneous users (the number of which is specified at the top of this license and is controlled and/or
monitored by a serial number placed within the master disk provided to you) who work at one site. A
Workgroup License does not allow the Software to be installed at more than one physical site. The
Software may be shared subject to these limitations by the licensed users in one of the ways outlined

below.

You may:

1. Install the Software in machine-readable form, on one server and/or one or more independent

computers (not exceeding the total number of licensed simultaneous users) at one site. Users who
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normally work at the site may access the Software on the one network server over a dial-up connection,
Local Area Network, Virtual Private Network, or its equivalent where the program is executed directly from

the single copy on that server;

2. Allow up to the number of licensed users who work at one site to use the Software at one time; and

3. Physically move the Software from one computer to another, provided the Software is installed on no
more computers than, and used by no more than the number of licensed users at one site at any one
time.

SUBSCRIPTION FOLDER LICENSE:

(Files saved on Apian servers, may or may not have purchased full SurveyPro license) You may install
copies of the Software as needed to access one or more subscription folders. A folder can be shared
among more than one user though only one can have access at a time and only one person may be

registered as the folder’s owner for administration and technical support.

Subscription Folders: A subscription folder allows you to keep one active SurveyPro project file for as
long as the folder is paid for (“active”). This file may be opened or saved from any copy of SurveyPro that
has access via the folder login codes. You may also have access to some earlier projects in that folder

during this activation on a read-only basis.

Apian makes commercially reasonable efforts to preserve your project files on its server, make them
available at your request and prevent unauthorized access, including but not limited to login
authentication, archive copies and backup web access, so long as you maintain a folder in an active paid-
up status. Apian does not promise to retain/archive files left in expired folders. Apian employs regular

archiving and deletion practices and files in expired folders will be deleted.

All folders automatically renew as long as your credit card remains valid. If credit card will no longer
process Apian will make reasonable efforts to contact you for updated billing information, and reserves
the right to terminate folders that are not paid for. Billing continues until Apian receives written notice of
www.Apian.com
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your intention to allow your folder(s) to expire, at least ten (10) days before the next billing cycle. No
refunds for processed billings or partial months will be made — this is a month-to-month prepaid service

only.

ALL LICENSES:

Backup Copy. You may make one (1) copy of the Software in machine-readable form solely for backup

purposes, provided that you reproduce all proprietary notices on the copy.

Transfer of Software. You may transfer your rights in the Software one time, from you to one other
person, provided you permanently transfer all rights under this Agreement, and not for the purposes of a

single project or segment of a project.

Limits on Modifications. You may not modify, translate, reverse engineer, decompile, disassemble, create
derivative works based on, or copy (except for the backup copy) the Software or accompanying materials
(except for sample code). You may not use or modify sample source code except as required for its use
with licensed Apian Software products. You may not remove any proprietary notices, labels or marks on

the software or accompanying materials.

NetCollect Web surveys. You may install on any Online server(s) HTML surveys exported from
NetCollect. Perl, ASP and other server application components included with NetCollect may be used
with NetCollect HTML surveys by licensed users of NetCollect, but may not be distributed separately,

reverse-engineered or used for other purposes.

DirectCollect surveys. You may distribute as many copies of the run-time survey data collector and team
interviewer modules as needed, or offer network access to them for respondents, without additional
licenses. Visual Basic source code included with DirectCollect may be modified and used with
DirectCollect by licensed users of DirectCollect, but may not be distributed separately, reverse-

engineered or used for other purposes.
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KeyCollect. You may install as many copies of the KeyCollect accessory program as you wish for data

entry to SurveryPro projects developed under this license.

Respondent EMailer. You may install as many copies of the Respondent EMailer accessory program as
you require to support SurveyPro projects developed under this license. The Respondent EMailer is not

licensed or supported for general use.

Apian supports responsible bulk mailing. The Respondent EMailer may be used only for mailings which
comply with: current "Spam" or Unsolicited Bulk E-mail legislation, Acceptable Uses or similar contractual

obligations you may have with your Internet service provider(s) and opt-in mailing lists.

Evaluation Software. Software identified as "Evaluation" or "Demonstration” may not be resold,

transferred or used for any purposes other than demonstration, test, or evaluation.

Upgrades and Conversions. If the Software is an upgrade of an earlier release, a conversion from
another Apian Software product, or fulfillment of a Beta Subscription, then you must cease using all
earlier versions except for transitional use during the upgrade. You may not loan, rent, sell or otherwise
transfer any earlier version. This license agreement replaces all prior license agreements effective with
installation of the Software, and prior Licenses for earlier versions are hereby terminated. Following
installation, the Entire agreement of both parties is governed by the terms of this current license

agreement, which supersedes all earlier versions.

Termination of License. Unauthorized copying of the Software (alone or merged with other software) or
the accompanying materials, or failure to comply with the restrictions in the License Agreement
automatically terminates this License Agreement. Upon termination of the license, you must remove the
Software from all computers on which it is installed, and destroy or return to Apian the Software,

accompanying materials, and any copies made by you.

Limited Warranty and Disclaimer. Apian Software, Inc. warrants the media on which the Software is
furnished to be free of defects in material and workmanship under normal use for a period of ninety (90)

days from the date of delivery to you as evidenced by a copy of your receipt. If any media does not
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conform to this limited warranty, your exclusive remedy is replacement of the media or, if Apian is unable

to deliver replacement media, refund of the purchase price and termination of the License Agreement.

NO OTHER WARRANTIES. EXCEPT FOR THE ABOVE WARRANTY, THE SOFTWARE AND
ACCOMPYING MATERIALS ARE PROVIDED WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS, IMPLIED, STATUTORY, IN ANY COMMUNICATION WITH APIAN SOFTWARE, INC., OR
OTHERWISE, INCLUDING WITHOUT LIMITATION IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. APIAN SOFTWARE, INC., DOES NOT WARRANT
THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET YOUR REQUIREMENTS OR
THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTRRUPTED OR ERROR FREE. THE
ENTIRE RISK AS TO THE USE, QUALITY, AND PERFORMANCE OF THE SOFTWARE IS WITH YOU.

SOME STATES DO NOT ALLOW EXCLUSION OF IMPLIED WARRANTIES SO THE ABOVE
EXCLUSION MAY NOT APPLY TO YOU. THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL
RIGHTS. YOU MAY HAVE OTHERS, WHICH VARY FROM STATE TO STATE.

LIMITATION OF LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, APIAN
SOFTWARE, INC., SHALL IN NO EVENT BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES
FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS
INFORMATION, OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY
TO USE THE SOFTWARE OR THE PROVISION OF OR FAILURE TO PROVIDE SUPPORT
SERVICES, EVEN IF APIAN SOFTWARE, INC. HAS BEEN ADVISED OF THE POSSIBLITY OF SUCH
DAMAGES. IN EVERY CASE, APIAN SOFTWARE, INC."'S MAXIMUM LIABILITY UNDER ANY
PROVISION OF THE LICENSE AGREEMENT SHALL BE LIMITED TO THE AMOUNT ACTUALLY PAID
BY YOU FOR THE SOFTWARE OR USD $5.00, WHICHEVER IS GREATER.

General. This agreement will be governed by the laws of the State of Washington. Any suit regarding
this License shall be brought only in King County, Washington. This Agreement is the entire agreement
between us and supersedes any other communications with respect to the Software and accompanying
materials. If any provision of this Agreement is held unenforceable, the remainder of this agreement shall
continue in full force and effect.
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U.S. Government Restricted Rights. Government Use. The Software and accompanying documentation
are deemed to be "commercial computer software" and "commercial computer software documentation,”
respectively, pursuant to DFAR Section 227.7202 and FAR Section 12.212, as applicable. Any use,
modification, reproduction, release, performance, display or disclosure of the Software and accompanying
documentation by the U.S. Government shall be governed solely by the terms of this License Agreement

and shall be prohibited except to the extent expressly permitted by the terms of the License Agreement.

If you have any questions, please contact the manufacturer in writing: Apian Software, Inc., 115 N 85th
Street, Suite 204, Seattle, WA 98103.
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